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Copyright 

 Copyright 2001 G.Mate, Inc. All rights reserved. 

 The contents of this manual may be changed without notice. 

  

 All proprietary ownerships of information included in this manual are protected by the copyright law. 

You are prohibited from copying or using any information in this manual without a documentary 

permission from G.Mate, Inc. 

  

 GMate, YOPY, Linupy, the GMate logo, YOPY logo, and the Linupy logo used in this manual are 

trademarks of G.Mate, Inc. Linux is a trademark of Linus Torvalds, and other trademarks or trade name 

may be used in this manual to designate a specific company, trade name, or trademark.  

 All copyrights of trademarks other than those owned by G.Mate Inc,  are owned by their respective 

owners.  

  

 G.Mate, Inc. is not responsible for any damage occurred in connection with use of this manual. G.Mate 

Inc is also not responsible for any loss or damage occurred by using any S/W that was not provided 

originally by G.Mate Inc.  
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About this manual 

  

 Thank you for purchasing the Linux Color PDA, YOPY.  

 This manual includes all detailed information on your using the YOPY, and will help you use the YOPY 

more easily and in no time. 

 We recommend that you read this manual first before using your YOPY.  

  

 This manual first explains the components of your YOPY, and then finishes the basic preparations for 

using your YOPY by performing the initial settings. By explaining the basic functions step by step, this 

manual will help you use your YOPY more effectively. Also, by explaining the basic application 

programs and how to customize your YOPY, this manual will enhance the efficiency of using your YOPY.  

  

 If you experience any inconvenience or troubleshooting while using your YOPY, please refer to this 

manual for help. 
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Chapter 1 Overview of YOPY  

 This chapter explains the features of your YOPY, its component, and the contents of the CD-ROM. 

  

What is YOPY? 
 The multimedia PDA YOPY uses the Linux OS developed by G.Mate, Linupy. With its slim size and 

folder type design, mobility, and high performance, YOPY is capable of providing entertainment contents 

such as images, games, or music, and the newest information on the Internet, from anywhere, at any time.  

The basic features of YOPY are as follows. 

  

Internet website access through wireless service network 

 You can realize a handheld information world using the internal web browser, while sending or receiving 

E-mails or accessing to PC communication services.  

  

Mobile entertainment 

 You can use the internal MP3 player to listen to high-quality music, and enjoy various games with its 

65,000-color display screen and powerful stereo sound. 

  

Fully accessible information management 

 All schedules and information can be inputted and fully accessed by day, week, or month. Moreover, 

easy input and management of addresses or phone numbers is also possible. When you have important 

appointments, the alarm function will help you fully manage your schedules and information.  

  

Easy voice recording 

 Sudden ideas or simple memos can be voice recorded, and easily played back. 

  

Installation of various application programs  

 You can also add various practical programs developed in the X Window environment of the Linux OS.  

  

The easy-to-use Key Pad 

 You can easily run application programs without using the Stylus Pen, by using the convenient 

Navigation Keys or the special keys. Also, fast character input is possible by using the character and 

number buttons on the Key Pad.  

  
YOPY Components 
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Locating front panel components 

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

1. Display Screen 

 Composed of a TFT-LCD supporting up to 65,536 colors, and a sensitive touch panel, it displays all the 

programs and information of YOPY.  

  

2. Power Key 

 Used to turn YOPY’s power on and off. 

  

3. Function Key 2 

 Carries out specific functions when using the MP3 player or playing games. Refer to each program 

instruction for details.  

  

4. Function Key 1 

 Carries out specific functions when using the MP3 player or playing games. Refer to each program 

instruction for details. 

  

5. Run Program Key 
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 Use this button to run programs, or use it as a “Play” button while using the MP3 player. 

  

6. Start Key 

 Use this button to open the Start Menu. Functions the same as (     ) on the task bar in the lower part 

of the screen. 

  

7. Soft Reset Key 

 Reboots the system. For details, see “Resetting your YOPY” in Chapter 3 of this manual. 

  

8. Serial Port 

 Use a serial cable to connect the serial or USB port on your computer with the cradle in order to 

synchronize your YOPY with your desktop computer. Also, by connecting an AC adapter, you can charge 

your YOPY’s battery.   

  

9. Microphone 

 Lets you record voices.  

  

10 Key Pad 

 Orders YOPY to input characters, run programs, etc. 

For details, see “Using the Key Pad to enter data” in Chapter 3 of this manual. 

  

11. Navigation Key 

 Moves the selected menu, moves the cursor while entering a text, or acts as a direction key when playing 

games. 
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12. Speaker 

 Outputs the sounds from YOPY.  

  

13. LED 

 Lights up when charging battery, or when the power is on. It also indicates the status of YOPY as an 

alarm, by blinking its lamp.  

Locating side panel components 

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

   

  

1. Earphone Jack 

 Connects a headphone to YOPY, for listening to music or playing games while not using the speaker.  

 

2. Hook 

 Tie a strap to this hook for convenient carrying and preventing loss of your YOPY.  

 

3. Scroll Key 

 A scroll bar appears when contents on the screen extend over the size of screen. The scroll button lets 

you move the scroll bar up and down. Press the lower scroll button to display information below the 

current viewing area, and press the upper button to see the information above.  
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4. Infrared Communication Port 

 Use this port to connect a mobile phone for infrared communication access to the Internet. For details, 

see “Internet / Network / Communication Services” in Chapter 6 of this manual. 

  

5. Multimedia Card (MMC) Slot 

 Insert a multimedia card in this slot. For details, see “Using the expansion kit” in Chapter 2 of this 

manual. 

  

YOPY Functions 

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

1. Program Title Bar 

 Displays the title of a program. By tapping the icon on the left side of the bar, you can close the program 

or adjust the window size.   

  

2. Display Control Button (              ) 

 Hides the program window, fits the window size to maximum, or closes a window.  
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3. Scroll Bar 

 Drag up or down with your Stylus Pen while pressing on the Scroll bar, to move to an area you cannot 

see on the program window.   

  

4. Task Bar 

 Even if there are many program windows on the screen, this bar is always shown on the bottom of your 

Desktop Screen. Also, for your convenience, the task bar can be moved to the top of the screen by 

dragging it using your Stylus Pen.   

  

5. System Time Icon (               ) 

 Displays the current time of your system. By double tapping it, a “Set Time” dialogue box will appear. 

For details, see “System Preferences” in Chapter 8 of this manual.  

  

6. Battery Icon 

 Displays the current status of your battery. 4 steps of battery status display (    ,    ,    ,    ), and 

the different icon shape when charging (     ), will let you know the current status of your battery. By 

double tapping it, a “Set Power” dialogue box will appear. For details, see “System Preferences” in 

chapter 8 of this manual.  

  

7. Sound Icon 

 Displays the current status of your sound – whether it is on (          ) or off  (      ). 

  

8. Multimedia Card (MMC) Icon 

 Insert your Multimedia Card in its slot and this icon (    ) will appear on the task bar. Remove the card 

to clear it.  

  

9. Network Connection Icon 

 Appears when your YOPY is connected to a network (the Internet). 

  

10 Korean/English Icon 

 Displays the current language input status (Korean/English). When Korean input is available (      ) is 

shown, while when English input is available (       ) appears.  

  

11. Keyboard Shift Button (    ) 

 Lets you shift to the Screen Keyboard or the Writing Recognizer for data input. 
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12. Screen Keyboard Button  

 Executes the Screen Keyboard for character input into your YOPY. For deta 

ils, see “Entering data into your YOPY” in Chapter 3 of this manual.  

  

13. Display Program Windows Button) 

 Displays all the windows opened on the screen. Windows that are minimized or hidden by other 

windows are also displayed. Tap this button to display the program window you wish to see. 

14. Start Button)  

 Runs the Start Menu. You can also run the Start Menu by tapping the Start Button at the right lower part 

of your YOPY’s Key Pad.   

  

15. Start Menu 

 Use this menu to run all the programs in your YOPY, or to set system preferences. The sub-menus for 

each menu are shown when you select the right arrow on the screen. 

  

(16) Desktop Screen 

 The first screen to appear when you start your YOPY. Select one from the Image Panel to change to a 

Desktop Screen you would prefer.   
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YOPY CD-ROM Components 
  

YOPY CD-ROM includes an Operating Instruction and applications that could be used in YOPY and 

your desktop PC. The components of your CD-ROM are as follows. 

  

* YOPY Demo Program 

 Explains the specifications and the basic operating instructions of your YOPY in movies or images.  

* YOPY Desktop Program 

 Install this into your desktop PC in order to synchronize your YOPY with your desktop PC, or 

add/remove programs. 

* YOPY Applications 

  - Web Browser 

- Email Client 

- MP3 Player 

- Engineering Calculator 

- English Korean Dictionary 

- Games  

Note 

The YOPY application programs included in your CD, are already installed in your YOPY. However 

you must reinstall each application program when you initialize your YOPY to factory settings. For 

details on program installation, see “Installing and uninstalling programs” in Chapter 7 of this manual. 

  

* Operating Instructions  

The Operating Instructions are in PDF format. In order to read or print PDF documents from your CD-

ROM, you are required to use the “Acrobat Reader” application program.. 

  

  

Note 

YOPY’s developer S/W and Operating Instructions can be downloaded at G.Mate’s official developer site 

(http://www.yopydeveloper.org), and will continuously be updated. 
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Chapter 2 Using your YOPY for the first time 

  

This chapter explains the basic settings you must make, before using your YOPY for the first time, step 

by step. The basic orders, before your first use of YOPY, are as follows. Recharging your battery, YOPY 

initial settings, using the YOPY Desktop S/W, using the expansion kit, and using other H/W. 

   

 Recharging the battery 
You must recharge your YOPY before first using it. 

  

Using the cradle 

You must recharge your YOPY before first using it. 

YOPY is equipped with a Lithium Polymer battery, and is automatically recharged by connecting an AC 

adapter to an outlet and its cable to the power port of your YOPY.  

  

The orders recharging the battery are as follows. 

 1. Connect the YOPY to the cradle 

 2. Connect the jack of the AC Adapter to the back of the USB connector of a cradle cable 

 3. Connect the AC adapter to an outlet 

  

Note 

You can perform recharging and synchronizing at the same time by connecting the USB connector a 

cradle cable to a USB port on your computer. 
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When charging, the LED lamp of YOPY turns on and keep on red and when fully charged, the LED lamp 

turns off. 

When first using your YOPY, the required time for a complete recharge may take about an hour and a half, 

while afterwards, it would become more faster. 

  

Note 

Please be aware that when your YOPY’s battery is completely discharged, all data saved in your YOPY 

POP is deleted, and YOPY is returned to factory settings.  

Initial settings of YOPY  
When first using your YOPY, or when Hard Reset is done, you must make the settings that appear on the 

screen. When first using your YOPY, follow the next orders. 

  

1. Press the power button. 

Press the power button of your YOPY, and the Initial Settings screen will appear with a buzzer sound.   

  

  

  

  

  

  

  

  

  

  

  

  

  

2. Adjust the coordinates. 

Coordinate adjustment lets your YOPY sense exactly the elements on your screen, when tapping them 

with your Stylus Pen.  

  

  

  

  

  

  

Initial settings screen 
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 Tap the center of the cross mark (    ) on your screen with the Stylus Pen.  

Tap the center of the moving cross mark until the screen changes. 

  

3. Set your time. 

After coordinate adjustment, a time setting screen will appear. 

You will see a time & date setting tab and a city setting tab on your screen. 

By setting the standard time and date of your current location, you will be able to see the times and dates 

of various cities around the world.  

  

  

  

  

  

  

  

  

  

  

  

  

Setting the standard time location 

Tap the downward arrow and you will see the standard time locations. Select your current location. 
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Setting the time 

  

1) Tap the time setting button. 

A time setting screen will appear. 

  

2) Use the arrow to set the current time ( hour, minute, second ). 

You may use the arrows or the Screen Keyboard to set the current time. Tap the hour, minute, or second 

input box with your Stylus Pen, and the Screen Keyboard will appear. Use your Screen Keyboard to enter 

the current time.  

  

Note  

By holding down the arrows ,you can set the time more faster, as the numbers automatically go up or 

down. 

  

3) Tap the OK button. 

 Time setting screen will close and the time will appear.  

Note  

Tap the daylight saving button to apply daylight saving time. 

  

Setting the date 

1) Tap the date setting button. 

A screen for date setting will appear. 
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2) Set the month and year using the arrows (     ). 

3) Tap the current date with your Stylus Pen. (The selected date will turn blue.) 

4) Tap the OK button. 

 Date setting screen will close and the date will appear. 

  

Note 

By setting area time, you can see the international time of a desired area automatically. When your 

desired city is not on the list, you may add the city on the city information tab. For details, see “Setting 

time” in Chapter 8, “Customizing your YOPY”, of this manual. 
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Using the YOPY Desktop software 
  

Use the YOPY Desktop software to synchronize your YOPY with your desktop PC. This enables you to 

maintain the latest data by comparing the information in your YOPY and your desktop PC. For details on 

using YOPY Desktop software, see Chapter 5, “Connecting with your desktop PC”, of this manual.  

  

YOPY Desktop software allows you to do the followings.  

 - Copy all information in your schedules, addresses, to do list , or expense programs, equally to your 

desktop PC, while in your desktop PC, input, edit, or print the information of each program.  

- Save the information of your YOPY in your YOPY Desktop software, and synchronize them.  

- Copy files freely between your YOPY and your desktop PC. 

- Install/remove external application programs. 

   

Installing YOPY Desktop software 

Do not just copy the YOPY Desktop software files to your desktop computer. You must run the setup file, 

and follow the following orders.  

  

1. Close all application programs in your desktop computer. 

All application programs must be closed before installing the Desktop software. Especially, anti-virus 

programs or short-cut bars (such as Microsoft Office) easily collide with the Desktop software, so be sure 

to close them before installation. 

  

2. Insert the Desktop software install CD-ROM in the CD-ROM drive of your desktop computer. 

In a few seconds, the Desktop software install wizard will appear. If the program does not run 

automatically, click the Start button , and then select Run. In the input window enter “d:\setup.exe ”. “d:” 

stands for the CD-ROM drive of your PC. 

  

  

3. Click the Next button. 

Click the Next button when the installation screen appears.  
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4. Follow the orders shown on the screen. 

Follow the orders shown on the screen and YOPY Desktop software will be installed. 

  

Note 

For details on running and using YOPY Desktop software, see Chapter 5, “Connecting with your desktop 

PC”, of this manual. 
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Using the expansion kit 
  

YOPY provides an expansion slot for using the Multimedia Card (MMC). MMC is an external storage 

media that is small and portable, and expands the storage capacity of your YOPY. Also, copying data 

from your YOPY to your MMC, or the opposite, is possible.   

  

Inserting Expansion Card 

Hold the body of your YOPY carefully and insert your expansion card according to the direction 

indicated on the card to the expansion slot of your YOPY. Press firmly with your thumb until you hear a 

sound. It is now fastened safely.  

  

  

  

  

  

  

   

  

  

  

  

  

  

Removing Expansion Card 

Hold the body of your YOPY carefully and press your expansion card softly, until the card springs up. 

Hold the card and pull it out of the expansion slot. 

  

Using other hardware 

The CDMA Module, Global Positioning System receiver, and etc, are sold separately in jackets. 

For details on installing or using these H/W, please refer to the manuals included in them. 
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Chapter 3 Basic Operations of your YOPY  

This chapter explains the basic operations of your YOPY to you - how to turn it  on/off, how to use the 

Stylus Pen, the scroll button, the Key Pad, how to input data, and how to reset. 

  

Turning on and off your YOPY  
  

Turning on your YOPY  

Press the power button. 

YOPY is turned on with a sound, and your most recently used screen will appear. 

  

Turning off your YOPY  

Press once again the power button. 

YOPY is turned off with a sound. 

  

  

Note  

For details on automatic power-off, to use your battery more effectively, see Chapter 8, “Customizing 

your YOPY” of this manual. 

  

 Using the Stylus Pen 
You can use the Stylus Pen provided with your YOPY, to run the functions that appear on the screen or to 

input data. 
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By tapping the Stylus Pen on the screen softly, you can run various functions or select elements. Also, by 

tapping and holding down your Stylus Pen, you can select number of elements simultaneously, or move 

an active program window to a location you wish. 

  

Use the Stylus Pen holder provided with your YOPY for loss prevention.  

  

Note : You can use the end of your Stylus Pen to press the reset button.  

   

Entering data into your YOPY  

The means of entering data into your YOPY are as follows – using the Screen Keyboard & DioPen, using 

the Key Pad, and synchronizing/copying data using the Desktop software. For details on data input using 

the Desktop software, see Chapter 5, “Connecting with your desktop PC”, of this manual. 

  

Using the Screen Keyboard to enter data 

When you would like to enter characters in a YOPY application program, use the Screen Keyboard on the 

lower part of your screen, for data input. 

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

The functions of each key of your YOPY Screen Keyboard are as follows. 

  

1. Backspace key : Deletes a character you have entered. 
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2. Enter key : Moves your cursor to the first space of the next line. 

3. Korean/English Shift key (K,A) : Shifts the keyboard for Korean or English input. 

4. Screen Keyboard location key (   ) : Moves the location of your Screen Keyboard to the top or bottom 

of screen.  

5. Tab key  : Lets you space at regular intervals. 

6. Caps key (Cap)  

Korean input keyboard : lets you input twin consonants, diphthongs, or symbols continuously. 

English input keyboard : lets you input capital letters or symbols continuously. 

Note  

When the Caps Lock key is pressed, the (del) key in the upper right part of your Screen Keyboard 

functions the same as the Backspace key  

7) Shift key (shf)  

Korean input keyboard : lets you input twin consonants, diphthongs, or symbols. 

English input keyboard : lets you input capital letters or symbols. 

8) Space key (      ) : Lets you input blank spaces. 
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 Using the Key Pad to enter data 

You can enter data fast and easily using the 8 function keys and 27 character keys (letters, numb ers, 

symbols) on your YOPY Key Pad, without using the Screen Keyboard.  

  

  

  

  

  

  

  

  

  

  

    <Korean included Key pad>                      <English Key Pad> 

  

Functions of each key of your YOPY Key Pad are as follows. 

  

Function key 

Function keys are colored blue, so are easily distinguishable from the character keys.  

  

1 Backspace key : Deletes an inputted character.  

2 Enter key : Lets you move to the first space of the next line. Functions the same as the Execute key 

(EXE) in the upper part of your Key Pad, and runs a selected program. 

3 Num·Sym key : Lets you input symbols or numbers, and acts as a toggle key. 

4 Start key: Functions the same as the Start key on the task bar at the bottom of your YOPY POP screen. 

Lets you run the Start menu and acts  as a toggle key.  

5 English/Korean shift key: Lets you shift between Korean and English input mode, and acts as a toggle 

key.  

6 Mute key : Mutes all the sounds coming out from your YOPY, and acts as a toggle key. (Only supported 

for English Key Pads.) 

7 Space key: Lets you input spaces. 

8 Caps key: Acts as a toggle key. 

  When inputting Korean : lets you input twin consonants or diphthongs continuously. 

When inputting English : lets you input capitals continuously. 

9 Shift key  

Korean input keyboard : Lets you input twin consonants, twin vowels, or commas (,). 
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English input keyboard : Lets you input capitals or commas (,). 

Note 

A toggle key is a key that changes its function each time you press it. The toggle keys on your YOPY 

POP Key Pad are the NumSym key, Start key, Mute key, and Caps key. 

  

Character key 

  

The arrangement of the character keys is quite different from your desktop PC keyboard. For your easy 

recognition of the key locations, the alphabets are arranged in orders from the upper left to the lower right. 

The numbers are arranged like that of a telephone or a mobile phone. Also, in a Korean included Key Pad, 

vowels are arranged in orders from the upper left to the lower right on the left three columns, while the 

consonants are arranged from the upper left to the lower right on the right three columns.  

  

 Resetting your YOPY  
If your screen or button does not response while using your YOPY, use the Reset Button to reboot your 

YOPY. 

  

 Soft Reset 

When rebooting, all unsaved data of the running programs or documents are deleted. However, all saved 

data in your YOPY are kept.  

  

In order to reboot, use your Stylus Pen to press the Reboot button located in the lower right part of your 

YOPY Key Pad. 
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Note : The Reboot button does not function when your YOPY’s power is off. 

  

 Hard Reset (to factory settings) 

When your problem is not solved even after a soft reset, you can run your YOPY by a hard reset. Be 

aware that when hard reset is done, all data will be erased, and your YOPY POP will return to factory 

settings.  

  

In order to make a hard reset, pull up the rubber cover of the hard reset button located at the bottom of 

your YOPY with your Stylus Pen, and softly press the Hard Reset button. 

  

  

Notes 

- When you run your YOPY after a hard reset, the Initial Settings screen will appear, and you need to 

make the initial settings (Coordinate adjustment, time/date settings) in the previously informed orders. 

- By running a hard reset, your user preferences are returned to factory settings. 
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 Chapter 4 Using basic applications 

This chapter explains in detail how to use the followings – the File Manager program (one of the various 

basic application programs installed in your YOPY), the Personal Information Manager program (date 

book/address book/to do list), the Memo Pad, Image Pad, Engineering Calculator, Clock, MP3 Player, 

Voice Recorder, and the Games. 

  

File Manager 
The File Manager is a program for managing general file/directory-related processes in your YOPY, 

including file/directory organizing and management, file/directory search, or file security settings. 

  

  

  

  

  

  

  

  

  

  

  

  

  

  

How to start 

1. Tap the Start button on the task bar in the bottom of your screen. 

2. Select “File Manager” in the Start Menu. 

Note 

You can use your Key Pad and follow the next orders to run the program. 

1. Press the Start button  on your Key Pad. 

2. Use the direction keys to select “File Manager” in your Start Menu. 

3. Press the EXE button on your Key Pad. 

  

How to exit 

1. Exiting from the menu bar 

 Select “File” on the menu bar, and select “Exit” from the bottom of the unfolded menu. 
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2. Closing the window 

 Select the  symbol on the right side of your program title bar to close File Manager 

Note 

You can also close File Manager by double pressing the icon on the left part of your program title bar, or 

pressing it once then selecting Exit from the unfolded menu. 

Viewing file/directory  

The File Manager lets you view files or directories from a detailed list or from a tree structure. By 

entering the path of the file or directory you wish to search in the address bar, you will be able to view it. 

  

Viewing file/directory 

With the initial settings of View file/directory, that is ‘View in detailed list’, you will be able to see the 

files or directories. In order to view the whole directory structure of your YOPY, you must change the 

setting to ‘View in tree structure’. For changing the setting to ‘View in tree structure’, tap on the icon tool 

bar and you will be able to view the directories in tree orders. 

  

Selecting file/directory 

Select a file/directory by tapping it with your Stylus Pen. Information of the selected file/directory will 

appear on the status bar at the bottom of your File Manager. Enter the path of a file in the address bar of 

your File Manager to view files/directories you wish.  

If you would like to select multiple files/directories, tap in the lower right part of your screen and then 

select the files/directories one by one. And you can select a bunch of files/directories at once by dragging 

the stylus pen without tapping or select files/directories at once with your Stylus Pen. Also, by selecting 

‘Select All’ in the Edit menu, you can select all the files in the current directory. 

  

In order to move to a sub directory, double tap a directory with your Stylus Pen, or select the sub 

directory you wish to move to and then select ‘Open’ from ‘File’ on the menu bar.  

In order to move to an upper directory, press on the tool bar. 

In order to move back to a former directory, press on the tool bar.   

  

Notes 

- During activating in the lower right part of the screen, you cannot use your Stylus Pen to select a bunch 

of files/directories at once. 

  

- When viewing directories in the tree structure mode, tap located left of the icon to view all sub 

directories included in the directory you have chosen, and tap  to hide them.  
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 Creating file/directory 

  

1. Select a folder location to create the new file or directory. 

2. Select “File” in the menu bar. 

3. Select “New”, and a list to select “Directory” or “File” will appear. 

4. Select the file or directory you wish to create. 

5. A box for inputting the file or directory name will appear. 

6. Tap the input box with your Stylus Pen and the Screen Keyboard will automatically appear. Use the 

Screen Keyboard to enter the file or directory name and press “OK”. 

  

Deleting file/directory 

1. Select the file or directory(s) you wish to delete. 

2. Select “File” in the menu bar. 

3. Select “Delete”, and the delete confirmation box will appear. 

4. Tap “OK” to delete the directory, or “Cancel” to cancel deleting.  

   

Symbolic Link 

Symbolic Link is a function similar to the “Short Cut” function of Windows. The Symbolic Link is an 

indirect file link using the pathnames, and is set to change its path when the location of the original file is 

changed, by indicating its location. 

   

1. Select the file/directory you wish to apply Symbolic Link on. 

2. Select “File” in the menu bar. 

3. Select “Symlink”, and the Symbolic Link box will appear. 
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 Note 

If you select “Symlink” without selecting a file or directory in advance, the Symbolic Link box does not 

appear. 

  

4. Tap the input box with your Stylus Pen and the Screen Keyboard will appear automatically. Use your 

Screen Keyboard to input the name of your Symbolic Link, or tap the “Search” button to select a file or 

directory you wish to apply Symbolic Link on. 

5. Tap the “OK” button. 

  

  

Bundling or compressing files/directories 

The File Manager supports a function to compress multiple files/directories in *.gZip format, or bundle 

them in *.tar format, into a single file or directory.  

   

Bundling files/directories 

1. Select 2 or more files/directories you want to bundle. 

2. Select “File” in the menu bar. 

3. Select “Tar”. 

4. A box to enter the name of the tar file will appear. 

6. Tap the box with your Stylus Pen and the Screen Keyboard will automatically appear. Use your Screen 

Keyboard to enter the tar file name, and add its extension, “.tar”. 

7. Tap the “OK” button. 

8. The file bundling process box will appear. When file bundling is finished, select the “OK” button. 

  Note 

When you tap the “Cancel” button during the file bundling process, file bundling stops and a tar file of 

bundled files or directories until the moment of your cancel will be created. 

  

Compressing files/directories 

1. Select files/directories to compress. 

Note 

You can select multiple files/directories and compress them at once. When directories are selected, all the 

files within the directories are also compressed. 

  

2. Select “File” in the menu bar. 

3. Select “gzip”. 

4. The file compression process box will appear. When compression is finished, the box will disappear 
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automatically and the compressed file will be created. 

  

Extracting file 

After selecting a compressed file, double tap it with your Stylus Pen or select “Open” in the menu bar to 

extract it. The contents will be extracted where your compressed file was. 

  

In the case of the Tar files, after selecting a Tar file, double tap it with your Stylus Pen or select “Open” in 

the menu bar. A box for locating where your tar file should be extracted will appear. Enter your path 

directly in the path input box, or use the “Search” button to select the desired location. 

   

Copying/cutting/pasting file/directory 

  

Copying file/directory 

1. Select the files/directories you wish to copy.  

  

Note 

You may select multiple files or directories. 

  

2. Tap “Edit” in the File menu. 

3. Select “Copy” in the unfolded menu.  

  

Cutting file/directory 

1. Select the files/directories you wish to copy.  

2. Select “Edit” in the File menu. 

3. Select “Cut” in the unfolded menu. 

  

Pasting file/directory 

1. Select the location where you would like to paste the copied/cut files. (For details on selecting 

locations, see the previously explained “View file/directory”) 

2. Select “Edit” in the File menu. 

3. Select “Paste” in the unfolded menu. 

  

Searching file/directory 

Use the file/directory search function in the File Manager to locate the desired files or directories within 

your YOPY system quickly.  

1. Select “Command” in the menu bar. 
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2. Select “Search” in the unfolded menu. 

3. The search box will appear. Enter the name or path of the file or directory you wish to search. The 

basic path of the file/directory you wish to search is the current path (.). Tap the “Search” button to select 

a path you wish to search in. 

4. Tap the “OK” button and the searched results window will appear.  

5. Confirm the path of the searched file or directory in the searched results window, and tap the “Close” 

button. 

  

Note 

When entering the name of a file or directory in the search box, use “*” (wild card) to enable extended 

search. For example, if you would like to locate “yopy.txt ”, type “y*” in order to search all files or 

directories starting with “y”, or “*.txt” to search all files with the extension “txt”. 

  

  

Synchronizing 

The Sync command is used for the maintenance of your YOPY’s file system. In order to maintain the 

original state of your file system, you must regularly run the Sync command. 

Normally, data are written first in a memory called the buffer cache before saved in the storage disk. The 

physical load of your data into the disk is delayed after being written to the buffer cache, until the 

following operation. 

- When your system requires buffer for the operation of another process  

- When the Sync command is executed  

 That is, when the Sync command is executed, your system empties those buffers and stores all data into 

your disk. 

For executing Sync in the File Manager, select “Command” in the menu bar and then select “Sync”. 

  

Changing file/directory properties 

Sets the general properties and permission of a file or directory. 

1. Select a file/directory. 

2. Select “Edit” in the menu bar.  

3. Select “Properties”. 

4. The properties box composed of two tabs, will appear. 

  

Changing file/directory name 

You may change your file/directory name in the file/directory properties box. Move your cursor to the 

name input box by tapping it with your Stylus Pen, and the Screen Keyboard will appear automatically. 
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Enter the new name of your file/directory.  

  

Note 

The file/directory names in the YOPY system directory, except /usr/local and /home, cannot be changed, 

because they are essential to system operation.   

  

Setting permission 

YOPY uses the Linux OS, and enables multiple users to use independently, preventing the access of other 

users to your files or recording other stuffs in them. Since one user can misuse others’ files, permission of 

each file or directory can be applied for preventing this. Only the authorized users (groups) would have 

access to those files. Using this property, each file or directory can either be shared with other people or 

used privately. The permission classes are divided into the followings – owner (User)/owner group 

(Group)/other users (groups) (Others). 

The ways to set the permission are as follows. 

1. Select a file/directory whose permission you wish to change. 

2. Select “File” in the menu bar and select “Property”. The property box will appear. 

3. Tap on the “Permission” Tab. 

4. Tap the “R,W,X” button for “User”, “Group”, and “Other” for permission settings. You can also apply 

specific permissions such as UID, GID, or Sticky. 

5. Set the owner and group of your file/directory.  

  

Note 

The meanings of “R,W,X” are as follows. 

R : Allow Read. 

W : Allow Write. 

X : Allow eXecute. 

  

  

Running application programs  

YOPY File Manager lets you run application programs automatically by selecting a file related to the 

application program and double tapping it with your Stylus Pen. When the selected file is not connected 

with the application program, it does not run. 
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  Personal Information Management System (PIMS) 
  

  

Schedule 

  

Contacts 

  

Tasks  

   

 Memo Pad 
Use the memo pad to store simple memos to your YOPY, or to edit an already saved text file (*.txt). Also, 

simple HTML documents can be made.  

  

 How to begin 

1. Tap the Start button on the task bar.  

2. When the Start Menu appears, tap “Program” and select “Memo Pad”. 

Note 

Use your Key Pad to run the program. 

1. Press the Start button on your Key Pad. 

2. Use the direction keys to select “Program” on the Start Menu. 

The program menu will appear. 

3. Use the direction keys to select “Memo Pad”. 

4. Press the EXE button on your Key Pad. 

 Exiting 

1. Exit from menu bar 

 Select “File” on the menu bar, and select “Exit” in the bottom of the unfolded menu. 

   

2. Closing the window 

Select    on the right side of the program title bar to close the Memo Pad. When you have not saved 

your document, a confirming window will appear, and ask if you would save your document. 

Note 

You can also close the program, by double tapping the icon located left of the program title bar, or tapping 

it once and then selecting ‘Exit’ from the menu. 

  

New / Open  

 Creating new document 
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Select “File” on the menu bar and select “New” from the unfolded menu. 

  

Opening document 

Opens a desired document. 

1. Select “File” on the menu bar, and select “Open”. 

2. The open file box will appear. Select a desired file and select “OK” to display the selected document on 

your screen. 

  

Open recent document 

Opens a recently edited document. 

1. Select “File” on the menu bar, and select “Open recent document” from the unfolded menu. 

2. From the recently opened documents, select the one you wish to display. 

  

Note  

Recent documents of the Memo Pad are set to show up to 4 most recent documents. 

  

Saving document 

   

Save 

Saves the currently opened document. 

1. Select “File” on the menu bar, and select “Save”. 

2. If the file name has not already been assigned, a file save box will appear. Assign the path where you 

wish to save your file, enter its name, and tap the “OK” button.  

The file is saved in the name you have entered, with an extension of “txt”. 

When there already exists the same file name, it will ask you, “File with the same name exists! 

Overwrite?”. Select “Yes” to overwrite, or “No” to cancel.  

   

Save as 

Saves the currently opened file with a new name. 

1. Select “File” on the menu bar of the currently editing file, and select “Save as”. 

2. The “Save as” box will appear.  

3. Assign the path where you would like to save your file, enter its name, and tap the “OK” button.  

The file is saved as the entered file name, with an ext ension of “txt”. 

When there already exists the same file name, it will ask you, “File with the same name exists! 

Overwrite?”. Select “Yes” to overwrite, or “No” to cancel. 
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Closing document 

Close 

Closes the currently opened file. 

1. Select “File” on the menu bar, and select “Close”. 

2. If the file has not been saved, the file save box will appear.  Select “Yes” to save your file, or “No” 

otherwise. 

   

Close all 

Closes all the currently opened files. 

1. Select “File” on the menu bar, and select “Close all”. 

2. If there is an unsaved file among the currently opened files, the file save box will appear.  Select “Yes” 

to save your file, or “No” otherwise. 

  

Editing document 

Use the various functions of your Memo Pad to edit documents. 

  

The functions and ways to use the Edit menu on the menu bar of your Memo Pad are as follows. 

  

1 Undo : Undoes the last change to your document. Tap the icon on the tool bar or select “Undo” from 

the Edit menu. 

The number of Undoes is decided within the capacity of available system memory.  

2 Redo : Redoes the last undo operation. Tap the icon on the tool bar or select “Redo” from the Edit menu. 

3 Undo all : Undoes all the changes done to your document. Tap the icon on the tool bar or select “Undo 

all” from the Edit menu 

4 Redo all : Redoes all the undo operations. Tap the  icon on the tool bar or select “Redo all” from the 

Edit menu. 

5 Cut : Cuts the desired text. Drag your Stylus Pen to activate (blue) a text you wish to cut, and tap the  

icon on the tool bar or select “Cut” from the Edit menu. 

6 Copy : Copies the desired text. Drag your Stylus Pen to activate (blue) a text you wish to copy, and tap 

the icon on the tool bar or select “Copy” from the Edit menu. 

7 Paste  : Pastes the already cut or copied text. Locate your cursor to where you wish to paste, and tap the  

icon on the tool bar or select “Paste” from the Edit menu. 

8 Select all : Selects all the contents of the current document. Select “Select all” from the Edit menu. 

9 Search : Searches specific characters or words. Select “Search” from the Edit menu or tap the icon on 

the tool bar and a search box will appear. Make the settings in the box, and tap the ‘Search’ button. 
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In the search box, there are four settings like below. The basic setting is “Start at cursor position”. Only 

one can be selected between “Start at cursor position” and “Start at beginning of the document”, and 

multiple selection is possible for “Case Sensitive” and “Regular expression search”. 

  

- Start at cursor position 

Starts the search from the current cursor position. 

- Start at beginning of the document 

Starts the search from the beginning part of document. 

- Case Sensitive 

Distinguishes capital and small letters.  

- Regular exp ression search 

Searches by regular expressions. Regular expression is a simple way of expressing a character string. 

The way to construct a regular expression, is to combine a normal character string with a meta 

character that implies a specific meaning. Use the regular expression as follows.  

  

[……]   Characters bound with [ ]. 

Example) Enter “[yo]” in the input box and tap the “Search” button to find characters or words including 

“y” or “o”.  

[^...]   Exception of certain characters bound with [ ]. 

Example) Enter “[^yo]” in the input box and tap the “Search” button to find characters or words without 

“y” or “o”.  

  

  

Search again : Redoes the recent search starting from the current cursor position. Select “Search again” 

from the Edit menu or tap the (     ) icon on the tool bar. 

  

  

Replace : Changes a specific character or word in the current document. Select “Replace” from the Edit 

menu or tap the (     ) on the tool bar, and the search/replace box will appear.  

  

  

 Enter the character or word you wish to search in the search box, make the search settings, and enter the 

character or word you wish to change in the replace box. By pressing “Search” first locate the character or 

word you wish to search, and then by pressing “Replace”, the selected character or word is replaced. This 

is repeated until all the characters or words in the documents are replaced. In order to change all of them 

at once, press “Replace all”. 
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 Goto Line #… 

Moves the cursor to a specific line (row) of the currently opened document.  

  

  

Enter the line number in the upper box, and press “Find” to move the cursor to the desired position. If you 

enter a line number that does not exists, an error message will appear. 

  

Option 

In order to use the input window of your Memo Pad with more space, you may hide the icon tool bar or 

move/hide the location of the title tab. You can also prevent the separation of Korean or English words in 

the input window.  

  

Select “Option” from the menu bar and the menu will unfold. The functions of each menu are as follows. 

  

Preventing word separation (Use Wordwrap) 

In your Memo Pad, basic settings are made so that the words are displayed continuously. In order to 

activate Wordwrap, select “Option” on the menu bar, and select “Wordwrap”.  

The Wordwrap function acts as a toggle key. 

  

Title tab location 

Hides the title tab or assigns its location. Basic settings are made so that the title tab appears on the top 

and by selecting “Toggle” from the “Title Tab” menu, you can hide it. Also, in order to assign its location, 

select “Top”, “Bottom”, “Left”, or “Right” from the “Title Tab” menu.  

  

Hiding tool bar 

Hides the tool bar for widening the input window. Select “Tool bar” from the “Option” menu. This 

function acts as a toggle key. 

  

  

  

  

Image Pad 
The Image Pad is a drawing tool for drawing simple images with your Stylus Pen, or editing images. You 

can also open images of various formats, while exporting them to another format. Images can also be used 

as the desktop screen of your YOPY.  
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 How to begin/exit 

  

How to begin 

1. Tap the “Start” button on the task bar.  

2. The Start Menu will appear. Tap “Program” and select “Image Pad”. 

Note 

You can also use the Key Pad to run the program. 

1. Press the Start button on your Key Pad. 

2. Use the direction keys to select “Program” in the Start Menu. 

The Program menu will appear. 

3. Use the direction keys to select “Image Pad”. 

4. Press the EXE button on your Key Pad. 

  

Exit  

1. Exit from menu bar 

 Select “File” on the menu bar, and select “Exit” from the unfolded menu. 

   

2. Closing the window 

Select on the right side of the program title bar. When your image has not been saved a confirming 

window will appear. 

Note 

You can also close the program by double tapping the icon on the left of the program title bar, or tapping 
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it once and then selecting “Exit”. 

  

  

Creating new image / opening image 

   

Creating new image 

1. Select “File” on the menu bar. 

2. Select “New File”. 

3. The Canvas box for setting the size of image will appear. The basic value is set to 240 X 320 pixels, 

and this can be changed. After setting the size of your image, press the “OK” button to create a new 

image of the desired size. 

  

  

  

  

  

  

  

  

Opening image 

1. Select “File” from the menu bar. 

2. Select “Open”. 

3. The open image box will appear. Select a file you wish to open and press “OK” to display the image on 

your screen.  

  

Note 

Image formats that can be opened in the Image Pad are as follows. 

- BMP : Basic file format of Image Pad.  

- GIF 

- JPG 

- TIF 

  

Saving image 

  

Save 

Saves the currently opened image. 
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1. Select “File” on the menu bar, and select “Save”. 

2. If the file name has not already been assigned, a file save box will appear. Assign the path where you 

wish to save your file, enter its name, and tap the “OK” button. 

The file is saved in the name you have entered, in the basic bmp format. 

When there already exists the same file name, it will ask you, “File with the same name exists! 

Overwrite?”. Select “Yes” to overwrite, or “No” to cancel. 

  

Save as 

Saves the currently opened file with a new name. 

1. Select “File” on the menu bar of the currently editing file, and select “Save as”. 

2. The “Save as” box will appear.  

3. Assign the path where you would like to save your file, enter its name, and tap the “OK” button. 

The file is saved in the name you have entered, in the basic bmp format. 

When there already exists the same file name, it will ask you, “File with the same name exists! 

Overwrite?”. Select “Yes” to overwrite, or “No” to cancel. 

  

Get Desktop 

Captures the current screen to Image Pad.  

1. Select “File” on the menu bar. 

2. Select “Get Desktop”. 

  

Creating YOPY desktop screen 

YOPY POP’s desktop screen can be customized freely.  

1. Open an image in Image Pad. 

2. Select “File” on the menu bar. 

3. Select “Set as Background”. 

  

  

Creating image 

You can create images using the various drawing tools of the Image Pad.  

The functions of Image Pad’s drawing tools are as follows.  

Drawing lines  

While pressing the screen with your Stylus Pen, drag the pointer (+) to draw a line. 

  

Drawing arcs  

While pressing the screen with your Stylus Pen, drag the pointer (+) to draw an arc. 
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In order to fill the arc boundary with a certain color, tap the “Draw arcs” tool, and then, while pressing the 

“Boundary fill” tool, draw your arc.  

Note 

Arc means a quarter of a circle or a oval.  

  

Drawing ovals  

While pressing the screen with your Stylus Pen, drag the pointer (+) to draw an oval. 

In order to fill the oval boundary with a certain color, hold on the “Boundary fill” tool and draw your oval. 

  

Drawing rectangles 

While pressing the screen with your Stylus Pen, drag the pointer (+) to draw a rectangle. 

In order to fill the rectangle boundary with a certain color, tap the “Draw rectangles” tool, and then, while 

pressing the “Boundary fill” tool, draw your rectangle.  

  

  

Drawing closed-curves  

While pressing the screen with your Stylus Pen, drag the pointer (+) to draw a closed-curve. 

In order to fill the closed-curve boundary with a certain color, tap the “Draw closed-curves” tool, and then, 

while pressing the “Boundary fill” tool, draw your closed-curve. 

Note 

 The “Draw closed-curves” tool connects automatically the starting point and end point of your drawing, 

and thus creates a closed-curve. 

  

Connecting line  

Tap a desired point with your Stylus Pen and then tap another point to connect the two points into a line.  

The “Connect to line” tool automatically connects the two points assigned with your Stylus Pen. 

  

Text input and style  

Text input 

1. Tap on the tool box. 

2. Tap your Stylus Pen softly where you wish to enter text. 

3. Use the Screen Keyboard on the bottom of your YOPY screen, or the DioPen to enter text. 

  

Style 

1. Tap on the tool box. 

2. The text style box will appear. 
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3. Select a font, style, and size from the text style box. (An example of the selected style will appear on 

the preview window. The font information tab of the text style box displays the information of the 

selected text style.) 

4. Confirm your settings and tap the “OK” button. 

Note  

The settings of your text style must be made before entering the text in the Image Pad screen in order to 

apply them. 

  

Erasing image 

  

Erasing a small part 

1. Tap  on the tool box. 

2. If the eraser color is different from the current background color, select the background color button at 

the bottom of the Image Pad to change the color.  

3. Tap softly with your Stylus Pen the part you wish to erase, and drag the pointer (    ).  

Note : The current background color is the eraser color. The background color can be changed by tapping 

the background color button at the bottom of the Image Pad into a color you wish.  

  

Erasing selected part 

  

Erasing selected closed-curve boundary 

1. Tap (    ) on the tool box. 

2. Select a part you wish to erase on the Image Pad with your Stylus Pen, by dragging it. (The start and 

end point of the selected boundary are automatically connected into a closed-curve, and the selected 

boundary will be displayed in blinking dots.) 

3. Select “Edit” on the menu bar, and select “Erase”, to erase the selected part. 

  

Erasing selected polygon boundary 

1. Tap (    ) on the tool box. 

2. Select a part you wish to erase on the Image Pad, by selecting several points with your Stylus Pen. (A 

polygon will be created automatically, and the selected boundary will be displayed in blinking dots.) 

3. Select “Edit” on the menu bar, and select “Erase”, to erase the selected part. 

  

Erasing whole screen 

1. Select “Edit” on the menu bar, and select “Select all”. 

(The whole screen will be displayed in blinking dots.) 
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2. Select “Edit” on the menu bar, and select “Erase”, to erase the selected part. 

   

Note : Used for filling the screen with the currently set background color.  

  

  

Setting color and painting 

  

Setting foreground color and background color 

 1. Foreground color : Used in all drawing tools except the eraser. Displayed as a rectangle in upper left 

of the color map on the bottom of the Image Pad. Foreground color can be assigned by tapping the color 

button on the color map. You can also customize your foreground color in the ‘foreground color settings’ 

box that appears by tapping the rectangle foreground color.  

  

 2. Background color : The base color of Image Pad and also used by the eraser. Displayed as a rectangle 

in lower left of the color map on the bottom of the Image Pad. Background color can be assigned on the 

background color box after tapping the lower rectangle.   

  

1. Color pad : Composed of colors that can be expressed in the Image Pad. 

2 Color pointer : Select a color on the color pad with your Stylus Pen.  

3 Brightness window : Displays the brightness of the selected color. Move your Stylus Pen up or down to 

elect a desired brightness.  

4 Color comparison window : Compares the selected color with white.  

5 Color scroll bar : Displays the values of selected color and brightness. Adjust each scroll bars to select 

the desired color.  

6 Color selection window : Enter values of 0~1 for red, green, and blue in order to select the desired color.  

  

  

Painting boundary or object 

1. Tap (     ) on the tool box. 

2. When the desired color is different from the current foreground color, select one in the color box. 

3. Tap a boundary or object you want to paint.  

  

Note : You can also paint the whole screen with foreground color.  
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Cutting, copying and pasting image 

  

Cutting image 

1. Select or  on the tool box, and select an image boundary you want to cut.  

2. Select “Edit” on the menu bar, and select “Cut”. 

  

Copying image 

1. Select or) on the tool box, and select an image boundary you want to copy. 

2. Select “Edit” on the menu bar, and select “Copy”. 

  

Pasting image 

1. Select “Edit” on the menu bar, and select “Paste”. 

2. The previously cut or copied image will appear on the screen. Use your Stylus Pen to drag it to a 

desired location. 

  

Image filters  

Use the filter function on the Image Pad menu bar, in order to select an image boundary and apply various 

effects.  

Use on the image tool box for selecting an image boundary. 

  

1 Smooth 

Smoothens the selected boundary so that it harmonizes the surrounding colors.  

2 Directional Smooth 

While being similar to Smooth, this function emphasizes the boundaries of the selected image. 

3 Despeckle 

Removes the noises of a selected image boundary. Those parts, except the parts with sudden contrast 

differences, are averaged. 

4 Convert to Grey scale 

Converts the selected image boundary to gray scale. 

5 Edge Detect 

Leaves only the edges of a selected image boundary. 

6 Emboss 

Analyzes the level value of an image, and turns it into a gray scale image of embossment or intaglio. 

  

7 Add Noise 

Adds irregular pixels to the selected image boundary.  
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8 Spread 

Adds irregular dots to the edges of the selected image boundary.  

9 Pixelize 

Converts the selected image into low resolution image. 

10 Solarize 

As one of the traditional film development processes, this function leaves the brightness of the dark part 

as it is, while darkening the bright part.  

   

 YOPY Engineering Calculator 
Use the YOPY Calculator to do not only the basic arithmetic operations such as addition, subtraction, 

multiplication, or division, but also engineering calculator operations such as trigonometrical function or 

calculation of number systems.  

The YOPY Calculator is consisted of the following 3 tabs – Basic tab for basic calculations, Advance tab 

for engineering calculation, and Additional tab for setting the units of angle, number system, decimal. 

The YOPY Calculator uses the Screen Keyboard or Key Pad instead of the calculator buttons to enter data. 

  

  

  

  

  

  

  

  

  

  

  

  

  

How to begin and exit 

  

How to begin 

1. Tap the Start button on the task bar.  

2. Select “Program” on the Start Menu, and select “YOPY Calculator”. 

Note 

You can also use the Key Pad to run the program. 

1. Press the Start button  on your Key Pad. 

Numerical 

formula window 

Result window 

Function buttons 
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2. Use the direction keys to select “Program” in the Start Menu. 

The Program menu will appear. 

3. Use the direction keys to select “YOPY Calculator”. 

4. Press the EXE button on your Key Pad. 

  

  

 

 

How to Exit 

Select  on the right side of the program title bar to end using your calculator.  

Note 

You can also close the program by double tapping the icon left of the program title bar, or tapping it once 

and then selecting “Exit”. 

  

Basic calculation 

The basic calculations of your YOPY calculator are done in the Basic tab. 

  

Functions of each button on the Basic tab are as follows. 

  

Clear : Erases everything displayed in the Numerical formula window, and the result window. The Clear 

button does not affect values saved in the memory of your calculator.  

BackSpace : Deletes characters in the Numerical formula window one by one, backwards. 

<- , -> : Moves the cursor in the Numerical formula window left or right. 

^ : Operates exponential functions. 

Ans : Displays the result value stored in the memory to your Numerical formula window. YOPY POP 

Calculator stores the previously calculated result in its memory, and this values can be recalled by using 

the Ans button.  

Exe : Displays the result of calculation in the Result window.  

+ : Operates addition. 

- : Operates subtraction.  

X : Operates multiplication. 

/ : Operates division. 

Pi : The value. (means the ratio of the circumference of a circle to its diameter.) 

e : The Euler number. 

EE : The exponential form of a number. For example, 1.567X10^3 (1.567e3) can also be inputted by 

pressing the following buttons in order - 1 . 5 6 7 EE 3.  
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. : Decimal point of a number. This is not applied when Decimal is set to 0 in the Additional Tab.  

(, ) : Used for priority calculation. For example, 1+2*3 would be 7. This follows the algebraic rule of 

applying multiplication or division before addition or subtraction. However if you input (1+2)*3, the 

result would be 9. This is because the calculation within (   ) is done first.  

   

Engineering calculation 

Use the buttons in the Advance tab of your YOPY Calculator to operate engineering calculations.  

  

<- History : Recalls the formula done before the result value to the Numerical formula window. 

History -> : Recalls the formula done after the result value to the Numerical formula window. 

Ln : Natural log calculation. 

Log : Log calculation with a 10 base. 

Exp : Exponential calculation with a Euler number base. 

Sin : Sine calculation. 

Asin : Inverse Sine calculation. 

Sinh : Hyperbolic Sine calculation. 

Cos : Cosine calculation. 

Acos : Inverse Cosine calculation. 

Cosh : Hyperbolic Cosine calculation. 

Tan : Tangent calculation. 

Atan : Inverse Tangent calculation. 

Tanh : Hyperbolic Tangent calculation. 

Sq : Square calculation. 

Sqrt : Sqaure Root calculation. 

Abs : Absolute value calculation. 

Or : Evaluates unique occurrences in two formulas. 

And : Evaluates commonalities between two formulas. 

Xor: Evaluates the exclusive OR between two formulas. 

H : Calculates the hexadecimal value of an inputted number. 

B : Calculates the binary value of an inputted number. 

O : Calculates the octal value of an inputted number.  

Neg : Multiplies an inverse symbol (+ or -) to the result value of a formula calculation or a number.  

Inv : Calculates the reciprocal of a number.  

! : Factorial calculation. Only the integers can be calculated. Otherwise, an error message will appear.  
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Additional Tab 

Settings such as units of angle, result value, number system, number of decimal point, can be done in the 

Additional Tab. 

  

Functions of the Additional buttons are as follows. 

  

Angle  : 3 units are available – Radian (Rad), Degree (Deg), and Gradian (Grad). 

Format :  

 Std : Displays the number of decimals of a result most adequately, considering the size of Result window. 

 Fix : Displays the number of decimals as set in the decimal number setting box. 

 Sci : Displays exponential and log mantissa between 1 and 9.999. 

 Eng : Displays the value that the decimal point of the Sci value has moved backwards by two digits. 

 Hex : Displays in hexadecimal system. 

 Bin : Displays in binary system. 

Oct : Displays in octal system. 

  

 

 

Decimals : You can assign the number of decimals that should be displayed in the Result window, 

using   . 

Clock 
YOPY Clock is a visual time clock program.  

     

 How to begin and exit 

  

How to begin 

1. Tap the “Start” button on the task bar.  

2. When the Start Menu appears, select “Program” and then select “YOPY Clock”. 

Note 

You can also use your key pad to run the program as follows. 

1. Press the Start button  on the Key Pad. 

2. Use the direction keys to select “Program” in the Start Menu. 

The program menu will appear. 

3. Use the direction keys to select “YOPY Clock”. 

4. Press the EXE button on the Key Pad. 
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How to Exit 

Select  on the right side of the program title bar to close the YOPY Clock. 

Note 

You can also exit from the program by double tapping the icon on the left side of the program title bar, or 

tapping it once and then selecting ‘Exit’ from the menu. 

  
  
  
 
 
MP3 Player 
YOPY MP3 Player enables you to enjoy CD quality digital music. With its 64MB high capacity memory, 

you can store and run many MP3 files. Also, your music will not be stopped when using it simultaneously 

with another application program, and various MP3 Player skins are usable.  

   

What is a MP3 file ? 

MP3 (MPEG1 Layer3) is a music file made from the international standard audio data compression 

technology. 

  

How to begin and exit 

How to begin 

1. Tap the “Start” button on the task bar.  

2. When the Start Menu appears, select “Multimedia” and then select “MP3 Player” 

Note 

You can also use your key pad to run the program as follows. 

1. Press the Start button on the Key Pad. 

2. Use the direction keys to select “Multimedia” in the Start Menu. 

The multimedia menu will appear. 

3. Use the direction keys to select “MP3 Player”. 

4. Press the EXE button on the Key Pad. 

  

How to Exit 

Tap the icon on the MP3 Player to close it. 
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Main functions  of the MP3 Player 

  

Playing MP3 file 

Tap the Play button on the MP3 Player to play the selected file.  

  

Adjusting volume 

Move the volume adjustment scroll bar on your MP3 Player to adjust volume.  

  

Stopping MP3 file 

Tap the Stop button on the MP3 Player to stop playing the selected file. 

When the Play button is pressed again after pressing the Stop button, the MP3 file is played from the 

beginning. 

  

Pausing MP3 files 

Tap the Pause button on the MP3 Player to pause. When the Play button is pressed again after pressing 

the Pause button, the MP3 file is played from the point of pause. 

  

Moving to a desired part while playing the MP3 file 

1. Moving to the next/previous MP3 file 

Tap  while playing to move to the previous MP3 file, and to move to the next file. 

2. Moving to a certain part in the same MP3 file 

Tap the desired part on the file playing bar of your MP3 Player, with the Stylus Pen. Music will be 

played from where you tapped the Stylus Pen. 

  

Repeating 

When  on the MP3 Player is pressed, the icon becomes activated, and the selected MP3file is repeated. 

Press once again to cancel repeat. 

  

Shuffling 

When on the MP3 Player is pressed, songs are played in random order.  
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Searching/adding/deleting MP3 file  

Use (      ) on the MP3 Player to open the Play List box, where you can search/add/delete MP3 files.  

  

Searching MP3 file  

At the left part of the Play List box, you will see the Directory box, where you can search the desired 

MP3 files. Select a directory and all the MP3 files included in the directory will appear in the File box. 

  

Adding MP3 file  

Select the MP3file in the File box with your Stylus Pen, and tap the “Add” button on the lower right, in 

order to add a MP3 file.  

  

Deleting MP3 file  

Select the MP3file in the File box with your Stylus Pen, and tap the “Delete” button on the lower right, in 

order to delete a MP3 file.   

  

Closing Play List box 

Tap the “Close” button on the lower right part of the Play List box, or press  on the right side of the title 

bar, to close the Play List box.  

  

  

Preferences 

Use (     ) on the MP3 Player to open the preferences box. The preferences box is composed of a 

general tab and a skin tab.  
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General tab 

1. Setting window location 

 Sets the location of your MP3 Player when it runs, in your YOPY screen. The setting menus are as 

follows. 

Check the menus in order to apply them. 

  

-Smart Window Placement : Locates your MP3 Player most adequate to screen size. 

-Remember Window Position : Stores the recent location of your MP3 Player in the memory and 

when you run your MP3 Player the next time, it appears at the saved position.  

  

2. Setting play interval of MP3 files 

Sets the interval of playing MP3 files in the Play List by the seconds.  

Use  to press up or down, or use the Screen Keyboard for value input. 

  

Skin 

Various skins other than the originally provided MP3 Player skin can be applied.  

Select the desired skin in the Skin box and then tap “Apply” to view the applied skin on your MP3 Player. 

    

Voice Recorder 

Sudden ideas or simple memos can be recorded in voices and played back afterwards. 

  

How to begin and exit 

How to begin 

1. Tap the “Start” button on the task bar.  

2. When the Start Menu appears, select “Multimedia” and then select “Voice Recorder”. 

Note 

You can also use your Key Pad to run the program as follows. 

1. Press the Start button  on the Key Pad. 

2. Use the direction keys to select “Multimedia” in the Start Menu. 

The multimedia menu will appear. 

3. Use the direction keys to select “Voice Recorder”. 

4. Press the EXE button on the Key Pad. 

  

How to exit 

1. Exit from menu bar 

 Select “File” on the menu bar, and select “Exit” in the bottom of the unfolded menu. 
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2. Closing the window 

Select     on the right side of the program title bar to close the Memo Pad. When you have not saved 

your recording, a confirming window will appear, and ask if you would save your recording. 

  

Note 

You can also close the program, by double tapping the icon located left of the program title bar, or tapping 

it once and then selecting ‘Exit’ from the menu. 

Recording/saving voice 

1. Select “New” in the File menu. 

2. Tap (    ) to begin recording. 

3. Tap (    ) to stop recording.  

4. Select “Save” in the File menu.  

  

Note 

Recorded files are saved in “.gsm” format.  

  

Playing recordings 

1. Select “Open” in the File menu. 

2. Find the path of the file you wish to play in the File open box, select it, and tap the “OK” button. 

3. Tap (       ) to play the selected file. 

4. Tap (          ) to stop playing the selected file. 

  

Preferences 

Limits of recording time or size can be customized. Select “Settings” in the menu bar and tap 

“Preferences”. The preferences box will appear. 
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Setting recording time limit 

 1. Setting recording time limit 

Enter a value in the recording time limit box by the minute to set the recording time limit. Use  to press 

up or down, or the Screen Keyboard to enter a value. Tap the check button to apply Recording time 

limit, and tap it again to disable. 

  

2. Automatic save box display 

This setting automatically displays the File save box when recording is finished. Tap the check button to 

apply Automatic save box display, and tap it again to disable. 

  

After finishing the settings, tap the “OK” button to apply Recording time limit.  

  

Settting recorded file size 

 Activate Set recorded file size by tapping the check button, and then use  to press up or down, or use 

the Screen Keyboard to enter a value. 

  

1. Automatic warning message display  

When recording file exceeds the assigned size, a warning message is displayed automatically.  

Note 

Recording still keeps going on after the warning message.  

  

2. Stopping recording 

When recording file exceeds the assigned size, recording stops.  

  

After finishing the settings, tap the “OK” button to apply Set recorded file size 

  

.  

  

Chapter 5 Connecting with your desktop PC 

This chapter explains how to connect your YOPY with your desktop PC, for additional use of your 

YOPY– how to install the Desktop S/W, how to connect with your desktop PC, how to use YOPY 

Desktop, how to synchronize/exchange data between your YOPY and your desktop PC,  and how to 

save/restore YOPY’s data 
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System Requirements 
The system requirements for installing and using the YOPY Desktop S/W are as follows. 

  

* Windows 98, Windows 2000 or Windows ME 

* Pentium II processor or greater 

* 32MB RAM or more 

* 50MB of available hard disk space 

* CD-ROM drive 

* VGA Monitor or better 

* Mouse 

* One available USB port  

   

Installing your Desktop software 
Before connecting your YOPY with your desktop PC, YOPY Desktop must be installed in your desktop 

computer.  

  

To install the YOPY desktop software, follow the following orders. 

  

1. Close all application programs in your desktop computer. 

All application programs must be closed before installing the Desktop software. Especially, anti-virus 

programs or short-cut bars (such as Microsoft Office) easily collide with the Desktop software, so be sure 

to close them before installation. 

  

2. Insert the Desktop software install CD-ROM into the CD-ROM drive of your desktop computer. 

In a few seconds, the Desktop software install wizard will appear. If the program does not run 

automatically, click the Start button (     ), and then select Run. In the input window enter 

“d:\setup.exe ”. “d:” stands for the CD-ROM drive of your PC. 

  

3. Follow the setup wizard. 

When installation is finished, the Desktop software program appears on the Program menu of the Start 

menu, and when running it for the first time, the program settings screen will appear. 

  
Connecting with your desktop PC 
Use the USB cable provided with your YOPY to connect with your desktop PC. The Desktop software is 

capable of various functions. 
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Note 

The YOPY Desktop S/W must be installed before connecting with your desktop PC using the USB cable. 

  

Using the USB cable 

Use the USB cable provided with your YOPY in order to connect your YOPY with your desktop 

computer. 

  

1. Connect the USB cable to your desktop PC. 

 Note 

 When you need to recharge and connect YOPY at the same time, connect the DC plug of your AC 

adapter to the DC Jack of the RS-232C cable, and connect the AC adapter to an outlet. 

  

2. Connect the other end of the USB cable to the RS-232C port at the bottom of your YOPY.  

  

Using the Serial cable 

You can also connect with your desktop PC using the Serial cable. 

  

Note 

The Serial cable is an optional accessory and must be purchased optionally.  

For details on YOPY’s accessories, see the YOPY Accessory Guide. 

  

1. Connect the Serial cable to the Serial port of your desktop PC. 

  

2. Connect the other end of the Serial cable to YOPY’s RS-232C port. 

  

 

  

 Chapter 6 Internet/Network/Communication Services  

This chapter explains you how to use your YOPY for access to the Internet, other networks, and 

communication services – how to use the infrared port or modem to access ISP, how to exchange Emails, 

and how to use the web browser for web surfing.  

  

Connecting to ISP 
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 Chapter 7 Installing and uninstalling programs 

This chapter explains how to install/uninstall programs other than the ones basically provided with your 

YOPY, that can be used on the Linux OS. There are 2 ways to install a program in your YOPY– using 

YOPY Desktop software, and the MMC, an external expansion kit.  

For the newest information on various programs, please visit G.Mate’s official site, 

www.yopydeveloper.org, for both the developers and users. 

  

Installing and uninstalling programs from YOPY Desktop 
Installing program 

1. Download or copy in a folder of your desktop PC the file you wish to install to your YOPY.  

2. Double click the YOPY Desktop icon on the desktop screen of your PC, or click the Start button of 

your windows, and select YOPY Desktop in the Program folder.  

3. Click the program install/uninstall icon (    ) on the lower left part of YOPY Desktop, and the 

program install/uninstall box will appear. 

4. Select user from the user dropdown list. 

 5. Click the add application button on the right, and the file select box will appear. 

 6. Select the desired file in the file select box, and click “Open”. The selected application will be 

installed in your YOPY POP immediately. 

  

Uninstalling program 
1. Double click the YOPY Desktop icon on the desktop screen of your PC, or click the Start button of 

your windows, and select YOPY Desktop in the Program folder. 

  

2. Click the program install/uninstall icon (    ) on the lower left part of YOPY Desktop, and the 

program install/uninstall box will appear. 

  

3. Select the program you wish to remove from the YOPY programs list at the bottom of the program 

install/uninstall box. 

  

4. Select the Uninstall button, and the selected program is removed from your YOPY.  

  

  

Installing program from Multimedia Card (MMC) 
You can also install from Multimedia Cards including the programs you wish to install.  
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1. Insert the Multimedia Card in your YOPY’s Multimedia Card slot. 

 (See Chapter 2 for how to insert a Multimedia Card into a slot) 

2. Tap the Start button of your YOPY, and select File Manager. 

3. Open the MMC directory in the File Manager, and double tap the file you wish to install, or select 

“Open” from “File” on the menu bar.  

  

 Chapter 8 Customizing your YOPY (Preferences) 

This chapter explains you how to change the preferences of your YOPY POP for your convenient use. 

YOPY’s preferences can be changed by selecting “Settings” in the Start Menu. 

  

  

How to run “Settings” 

1. Tap the Start button and select “Settings”. 

2. When the control panel screen appears, select a setting icon you wish to change, and select EXE or 

double tap it with your Stylus Pen. 

  

  System Preferences 
  
Setting sounds 

In the YOPY sound settings screen, you can adjust the volume of the speaker or the microphone, and 

assign sounds to specific operations (events) of application programs. You can also set the alarm mode 

when alarm function is activated in the Date Book. 

  

Speaker/microphone volume 

Move the speaker or microphone volume adjust bar with your Stylus Pen left or right, in order to adjust 

volume. 

  

  

  

  

  

  

  

  

  



62 

 1. Adjust the speaker volume. 

2. Adjust the bass volume of the speaker.  

3. Adjust the treble volume of the speaker. 

4. Mark the check button to mute the speaker.   

  

Assigning sounds to the event 

Assign sounds to operations (events) occurred in the system or application programs. 

1. Mark the check button to select whether event sound should be activated or disabled. 

2. Events are divided into User Interface events and System events, and sounds can be assigned to each 

event. 

3. You can change the assigned sound of an event. Follow the next orders. 

1) Select an event whose sound you wish to change. 

2) Tap the “Search” button to search/select the sound file, and then tap the “OK” button. 

3) Tap the Play button to confirm the sound of the file. 

4) Tap the “OK” button. 

  

 ssigning alarm mode 

Lets you set the alarm mode when the alarm function is activated in the Date Book program. 

  

There are two ways to assign the alarm – displaying a message on the screen, and informing with a sound. 

The sound can also be set to be repeated. 

You can assign a sound file to the alarm sound other than the preset sound, by following the next orders. 

  

1 Tap the “Search” button to search/select the sound file, and tap the ”OK” button. 

2 Tap the Play button to confirm the sound of file. 

3 Tap the “OK” button. 

System information 

In the System information screen, you will be able to view information on the YOPY POP system, and its 

memory status. 

  

 System information 

Displays YOPY’s operating system (OS), processor, screen size, GTK version, host name, and the system 

status. 
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 File system 

Displays YOPY’s File system information. 

   

 Memory status 

Displays YOPY’s memory status - rate of total memory use, YOPY’s total memory size, currently used 

memory size, available memory size, etc. 

  

Setting powers 

Set your YOPY’s power settings such as current battery status, automatic power off, and the battery 

warning message 

  

1. Check YOPY’s battery status in percentage (%). 

2. By moving the remaining battery power bar, you can assign the state of the 1st YOPY battery warning 

message. When the battery power is lowered to the assigned state, the warning message is automatically 

displayed. 

3. By moving the remaining battery power bar, you can also assign the state of the 2nd YOPY battery 

warning message. When the battery power is lowered to the assigned state, the warning message is 

automatically displayed. 

Note 

The remaining battery power of the 2nd warning message must be assigned lower than that of the 1st 

warning message. When battery status becomes 0%, we recommend you not to turn on the power, and 

recharge your YOPY quickly.  

Setting automatic power off 

When no operation is done by the user for a certain period of time, while YOPY is turned on, YOPY is 

turned off automatically for battery saving. The automatic power off setting can be set in two cases – 

when YOPY uses internal battery power, or when external power is connected. 

  

1. Mark the check buttons in order to activate automatic power off of internal battery or external power.  

2. Tap the Menu list button and select a desired time. 

3. Tap the “OK” button. 
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Setting time 

You can set the time and date of your current location, and view international times of cities worldwide. 

For details on setting time and date, see Chapter 2, “Using your YOPY for the first time” of this manual. 

Editing city information 

By setting the time and date of your current location, you are able to see the times and dates of each cities 

around the world. You can also edit/delete the standard times of each international cities, and add a 

standard time of a specific city. 

  

 If you would like to edit a standard time of a preset city, select the city you wish to edit, and tap the 

“Edit” button to edit in the ‘city standard time setting’ box. 

If you would like to delete a standard time information of a preset city, select the city and tap “Delete”. 

Also, if you would like to add a standard time information of another city, other than the preset cities, tap 

the “Add” button, and enter the standard time information in the ‘city standard time setting’ box.   

  

Setting coordinates 

Coordinate adjustment lets your YOPY sense exactly the elements on your screen, when tapping them 

with your Stylus Pen. When you first run your YOPY, or after a hard reset, the coordinate adjustment 

window appears, and you can perform coordinate adjustment when your Stylus Pen does not sense the 

screen elements exactly. For details on coordinate adjustment, see Chapter 2, “Using your YOPY for the 

first time” of this manual. 

Entering owner information 

You can edit owner information in the personal information settings screen. You may also assign a 

password to your YOPY for protection of the saved data in your YOPY.  

  

Inputing/editing owner information 

You can input/edit owner name, address, phone number, mobile phone number, Email address, and other 

information with your Screen Keyboard or the Key Pad. 
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Assigning password 

1. Tap the Assign password tab, and the ‘assign password’ box will appear. 

  

 Note 

When tapping the “OK” button after entering nothing in the password input box, a message asking you to 

retype your password will appear. The password can be entered up to 8 characters. 

2. Tap the “OK” button. 

3. The ‘password setting confirmation’ box will appear. Tap the “OK” button. 

4. A box containing a button for checking whether to activate password when you turn on the power, and 

a button for changing the password will appear. Tap the check button for activating password when power 

is turned on. If you would like to change the previous password, tap the change password button, enter a 

new password in the new password box, and tap the “OK” button. 

5. By turning off and on the power after assigning the password, a login screen will appear. Enter the 

assigned password to login. 

  

Note 

The login screen is for checking the assigned user, and access of all users except the assigned user will be 

denied. This enables safe protection of your data saved in YOPY.  

You must be careful not to forget the password. Because of you do, you have to do “Hard Reset” 

 Chapter 10 Additional Information 

Specification 
Processor 

206 MHz Strong ARM 32-bit RISC Processor 

OS 

ARM Linux (Linupy), X window System 

Display 

3.5 Inch 240x320 True Color (65K) TFT LCD  

Memory 

RAM 64MB , 16MB ROM  

  Interfaces 

Key Pad (40 Keys) , RS-232C / USB (Client) 

IrDA (115Kbps), Multimedia Card Slot 

Scroll Key, Speaker / Microphone , Earphone Jack (Ø3.5mm Stereo) 

 Size / Weight 

4.0”x2.7”x0.6” / 5.0oz 
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Battery 

1280mAh Rechargeable Li-ion Polymer Battery 

Application 

 - PIMS : Schedule, Contacts, Tasks 

 - Web Browser / E-mail 

 - MP3 Player / Voice Recorder / Memo Pad / Image Pad 

 - Engineering Calculator 

 - Games 

 - Hand Writing Recognition S/W, DioPen / File Manager / Control Panel 

* Please refer to the G.Mate, Inc. official site, http://www.yopydeveloper.org 

   for the newest information on software upgrade and various programs. 

Compatible PIM Program  

 - Microsoft Outlook, Lotus Notes 

  

The specifications of this product are subject to change for without notice 

  

  

  

  

Product Warranty 

The limited warranty of the hardware lasts for a period of 12 months from the original date of purchase. 

When a problem occurs during proper use of this product within this period, G.Mate will supply new or 

rebuilt replacement parts in exchange for defective parts, or if this is not possible, refund the product, at 

G.Mate’s option. Any replacement parts will be warranted for the remainder of the original wa rranty 

period or ninety calendar days from delivery, whichever is longer.  

The limited warranty of the software lasts for a period of 90 calendar days from the original date of 

purchase, and all problems occurred by using third party software are not warranted. We do not guarantee 

satisfaction of all purchasers with the software provided in this product, and do not guarantee operation 

with third party products.  

  

Conditions to receive Product Warranty Services 

  

In order for the purchaser to receive any wa rranty service, he/she must be able to prove the date of 

purchase (receipt) and acquire approval from G.Mate. Product that has not acquired service approval from 

G.Mate cannot receive any warranty service. 

G.Mate informs the approval number and delivery procedures to its purchaser who has requested service. 
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Product that requires service must be sent to G.Mate, with the cost of delivery paid by the purchaser, 

within 10 days, and the purchaser is responsible for all problems that occur during delivery. Product that 

has been safely delivered to G.Mate is repaired or exchanged within 30 days, and sent back to purchaser, 

with the cost of delivery paid by G.Mate. IF DURING THE REPAIR OF THE PRODUCT THE 

CONTENTS SAVED IN THE PRODUCT ARE ALTERED, DELETED OR IN ANY WAY MODIFIED, 

G.Mate IS NOT RESPONSIBLE FOR WHATSOEVER. 

  

Conditions you cannot receive Product Warranty Services 

  

If G.Mate determines that a problem has occurred due to any of the followings, you cannot receive any 

product warranty service. 

  

1. Having not purchased the product from G.Mate or G.Mate authorized reseller 

2. Acts of God, accident, misuse, abuse, negligence of this product 

3. Modification, or using parts G.Mate has not manufactured or sold 

4. Problems due to repair by any other party other than G.Mate 

5. Improper operation unwritten in the manual of this product 

6. Consumable items  

7. Problems due to communication service or other hardware used by purchaser 

  

Limited warranty 

  

G.Mate’s limited warranty covers the repair, exchange, or refund of product at G.Mate’s option, related to 

sales, use, and function of product. G.Mate is not responsible for any other problems than these. 

  

For warranty service application, or if you have any questions 

  

Internet: www.gmate.com 

Phone: 82-31-738-1230 

Fax:   82-31-738-1212 
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  GNU Library General Public License 

Version 2, June 1991  

Copyright © 2000 Free Software Foundation, Inc. 

59 Temple Place, Suite 330, Boston, MA 02111-1307  USA 

  

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is 

not allowed. 

  

Preamble  

The licenses for most software are designed to take away your freedom to share and change it. By 

contrast, the GNU General Public License is intended to guarantee your freedom to share and change free 

software - to make sure the software is free for all its users. This General Public License applies to most 

of the Free Software Foundation's software and to any other program whose authors commit to using it. 

(Some other Free Software Foundation software is covered by the GNU Library General Public License 

instead.) You can apply it to your programs, too. 

  

When we speak of free software, we are referring to freedom, not price. Our General Public Licenses are 

designed to make sure that you have the freedom to distribute copies of free software (and charge for this 

service if you wish), that you receive source code or can get it if you want it, that you can change the 

software or use pieces of it in new free programs; and that you know you can do these things.  

  

To protect your rights, we need to make restrictions that forbid anyone to deny you these rights or to ask 

you to surrender the rights. These restrictions translate to certain responsibilities for you if you distribute 

copies of the software, or if you modify it. For example, if you distribute copies of such a program, 

whether gratis or for a fee, you must give the recipients all the rights that you have. You must make sure 

that they, too, receive or can get the source code. And you must show them these terms so they know their 

rights.  

  

We protect your rights with two steps: copyright the software, and offer you this license which gives you 

legal permission to copy, distribute and/or modify the software.  

Also, for each author's protection and ours, we want to make certain that everyone understands that there 

is no warranty for this free software. If the software is modified by someone else and passed on, we want 

its recipients to know that what they have is not the original, so that any problems introduced by others 

will not reflect on the original authors' reputations.  
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Finally, any free program is threatened constantly by software patents. We wish to avoid the danger that 

redistributors of a free program will individually obtain patent licenses, in effect making the program 

proprietary. To prevent this, we have made it clear that any patent must be licensed for everyone's free use 

or not licensed at all.  

  

The precise terms and conditions for copying, distribution and modification follow.  

  

TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION 

Section 0 

This License applies to any program or other work which contains a notice placed by the copyright holder 

saying it may be distributed under the terms of this General Public License. The "Program", below, refers 

to any such program or work, and a "work based on the Program" means either the Program or any 

derivative work under copyright law: that is to say, a work containing the Program or a portion of it, 

either verbatim or with modifications and/or translated into another language. (Hereinafter, translation is 

included without limitation in the term "modification".) Each licensee is addressed as "you".  

  

Activities other than copying, distribution and modification are not covered by this License; they are 

outside its scope. The act of running the Program is not restricted, and the output from the Program is 

covered only if its contents constitute a work based on the Program (independent of having been made by 

running the Program). Whether that is true depends on what the Program does.  

  

Section 1 

You may copy and distribute verbatim copies of the Program's source code as you receive it, in any 

medium, provided that you conspicuously and appropriately publish on each copy an appropriate 

copyright notice and disclaimer of warranty; keep intact all the notices that refer to this License and to the 

absence of any warranty; and give any other recipients of the Program a copy of this License along with 

the Program.  

  

You may charge a fee for the physical act of transferring a copy, and you may at your option offer 

warranty protection in exchange for a fee.  

  

  

Section 2 

You may modify your copy or copies of the Program or any portion of it, thus forming a work based on 

the Program, and copy and distribute such modifications or work under the terms of Section 1 above, 

provided that you also meet all of these conditions:  
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You must cause the modified files to carry prominent notices stating that you changed the files and the 

date of any change.  

  

You must cause any work that you distribute or publish, that in whole or in part contains or is derived 

from the Program or any part thereof, to be licensed as a whole at no charge to all third parties under the 

terms of this License.  

  

If the modified program normally reads commands interactively when run, you must cause it, when 

started running for such interactive use in the most ordinary way, to print or display an announcement 

including an appropriate copyright notice and a notice that there is no warranty (or else, saying that you 

provide a warranty) and that users may redistribute the program under these conditions, and telling the 

user how to view a copy of this License.  

 

Exception: 

If the Program itself is interactive but does not normally print such an announcement, your work based on 

the Program is not required to print an announcement.) 

  

These requirements apply to the modified work as a whole. If identifiable sections of that work are not 

derived from the Program, and can be reasonably considered independent and separate works in 

themselves, then this License, and its terms, do not apply to those sections when you distribute them as 

separate works. But when you distribute the same sections as part of a whole which is a work based on 

the Progra m, the distribution of the whole must be on the terms of this License, whose permissions for 

other licensees extend to the entire whole, and thus to each and every part regardless of who wrote it.  

  

Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by 

you; rather, the intent is to exercise the right to control the distribution of derivative or collective works 

based on the Program.  

  

In addition, mere aggregation of another work not based on the Program with the Program (or with a 

work based on the Program) on a volume of a storage or distribution medium does not bring the other 

work under the scope of this License.  

Section 3 

You may copy and distribute the Program (or a work based on it, under Section 2 in object code or 

executable form under the terms of Sections 1 and 2 above provided that you also do one of the 

following:  
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Accompany it with the complete corresponding machine-readable source code, which must be distributed 

under the terms of Sections 1 and 2 above on a medium customarily used for software interchange; or,  

  

Accompany it with a written offer, valid for at least three years, to give any third party, for a charge no 

more than your cost of physically performing source dis tribution, a complete machine-readable copy of 

the corresponding source code, to be distributed under the terms of Sections 1 and 2 above on a medium 

customarily used for software interchange; or,  

  

Accompany it with the information you received as to the offer to distribute corresponding source code. 

(This alternative is allowed only for noncommercial distribution and only if you received the program in 

object code or executable form with such an offer, in accord with Subsection b above.)  

  

The source code for a work means the preferred form of the work for making modifications to it. For an 

executable work, complete source code means all the source code for all modules it contains, plus any 

associated interface definition files, plus the scripts used to control compilation and installation of the 

executable. However, as a special exception, the source code distributed need not include anything that is 

normally distributed (in either source or binary form) with the major components (compiler, kernel, and 

so on) of the operating system on which the executable runs, unless that component itself accompanies 

the executable.  

  

If distribution of executable or object code is made by offering access to copy from a designated place, 

then offering equivalent access to copy the source code from the same place counts as distribution of the 

source code, even though third parties are not compelled to copy the source along with the object code.  

  

Section 4 

You may not copy, modify, sublicense, or distribute the Program except as expressly provided under this 

License. Any attempt otherwise to copy, modify, sublicense or distribute the Program is void, and will 

automatically terminate your rights under this License. However, parties who have received copies, or 

rights, fro m you under this License will not have their licenses terminated so long as such parties remain 

in full compliance.  

  

Section 5 

You are not required to accept this License, since you have not signed it. However, nothing else grants 

you permission to modify or distribute the Program or its derivative works. These actions are prohibited 

by law if you do not accept this License. Therefore, by modifying or distributing the Program (or any 

work based on the Program), you indicate your acceptance of this License to do so, and all its terms and 
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conditions for copying, distributing or modifying the Program or works based on it.  

  

Section 6 

Each time you redistribute the Program (or any work based on the Program), the recipient automatically 

receives a license from the original licensor to copy, distribute or modify the Program subject to these 

terms and conditions. You may not impose any further restrictions on the recipients' exercise of the rights 

granted herein. You are not responsible for enforcing compliance by third parties to this License.  

  

Section 7 

If, as a consequence of a court judgment or allegation of patent infringement or for any other reason (not 

limited to patent issues), conditions are imposed on you (whether by court order, agreement or otherwis e) 

that contradict the conditions of this License, they do not excuse you from the conditions of this License. 

If you cannot distribute so as to satisfy simultaneously your obligations under this License and any other 

pertinent obligations, then as a consequence you may not distribute the Program at all. For example, if a 

patent license would not permit royalty-free redistribution of the Program by all those who receive copies 

directly or indirectly through you, then the only way you could satisfy both it and this License would be 

to refrain entirely from distribution of the Program.  

  

If any portion of this section is held invalid or unenforceable under any particular circumstance, the 

balance of the section is intended to apply and the section as a whole is intended to apply in other 

circumstances.  

  

It is not the purpose of this section to induce you to infringe any patents or other property right claims or 

to contest validity of any such claims; this section has the sole purpose of protecting the integrity of the 

free software distribution system, which is implemented by public license practices. Many people have 

made generous contributions to the wide range of software distributed through that system in reliance on 

consistent application of that system;  it is up to the author/donor to decide if he or she is willing to 

distribute software through any other system and a licensee cannot impose that choice.  

  

This section is intended to make thoroughly clear what is believed to be a consequence of the rest of this 

License.  

  

Section 8 

If the distribution and/or use of the Program is restricted in certain countries either by patents or by 

copyrighted interfaces, the original copyright holder who places the Program under this License may add 

an explicit geographical distribution limitation excluding those countries, so that distribution is permitted 
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only in or among countries not thus excluded. In such case, this License incorporates the limitation as if 

written in the body of this License.  

  

Section 9 

The Free Software Foundation may publish revised and/or new versions of the General Public License 

from time to time. Such new versions will be similar in spirit to the present version, but may differ in 

detail to address new problems or concerns.  

  

Each version is given a distinguishing version number. If the Program specifies a version number of this 

License which applies to it and "any later version", you have the option of following the terms and 

conditions either of that version or of any later version published by the Free Software Foundation. If the 

Program does not specify a version number of this License, you may choose any version ever published 

by the Free Software Foundation.  

  

Section 10 

If you wish to incorporate parts of the Program into other free programs whose distribution conditions are 

different, write to the author to ask for permission. For software which is copyrighted by the Free 

Software Foundation, write to the Free Software Foundation; we sometimes make exceptions for this. Our 

decision will be guided by the two goals of preserving the free status of all derivatives of our free 

software and of promoting the sharing and reuse of software generally.  

  

  

  

NO WARRANTY 

  

Section 11  

BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR 

THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN 

OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES 

PROVIDE THE PROGRAM "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER 

EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES 

OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS 

TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE 

PROGRAM PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, 

REPAIR OR CORRECTION.  
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Section 12 

IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL 

ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR 

REDISTRIBUTE THE PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR 

DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL 

DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE PROGRAM (INCLUDING 

BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR 

LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF THE PROGRAM TO 

OPERATE WITH ANY OTHER PROGRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS 

BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.  

  
  
  
  
  
  
  
  
  
  
  
  
  
FCC Statement 
This device complies with part 15 pg the FCC Rules. Operation is subject to the following two 

conditions: 1) This device may not cause harmful interference, and 2) this device must accept any 

interference received, including interference that may cause undesired operation. 

  

Caution: Any changes or modifications in construction of this device which are not expressly approved 

by the party responsible for compliance could void the user’s authority to operate the equipment. 

  

Note: This equipment has been tested and found to comply with the limits for a Class B digital device, 

pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against 

harmful interference in a residential installation. This equipment generates, uses and can radiate radio 

frequency energy and, if not installed and used in accordance with the instructions, may cause harmful 

interference to radio communications, However, there is no guarantee that interference will not occur in a 
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particular installation. If this equipment does cause harmful interference to radio or television reception. 

Which can be determined by turning the equipment off and on, the user in encouraged to try to correct the 

interference by one or more of the following measures: 

- Reorient or relocate the receiving antenna 

- Increase the separation between the equipment and receiver. 

- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected. 

- Consult the dealer or an experienced radio/TV technician for help. 

  

  


